
 

 

 

 

 

 

 

 

 
K2’s Road to Excellence 
Power Excel – Session 1 

Analysis 
 

This session will introduce you to tools for organizing, managing, and manipulating data. All too often, 
end-users rely on manual processes and techniques for these activities, notwithstanding the fact that 
Excel provides a terrific toolbox to assist in these efforts. With the Watch Window, Scenario Manager, 
Goal Seek Forecast, Break Analysis and Solver at your disposal, you have tremendous opportunities to 
improve your productivity when working with datasets of any size in Excel.  
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Watch Window 
Have you ever changed assumptions in a workbook and then rearranged the workbook or worksheets to 
view the impact of the change on some calculation of interest, only to change the assumptions again and 
again, each time rearranging the workbook to view the results? The Watch Window allows users to view 
in the current window the changes in other cells resulting from changes in assumptions. In fact, the Watch 
Window allows users to track cell properties of every type (workbook, worksheet, defined name, cell, 
value, and formula), while the cells are out of view. Essentially, the Watch Window is a cell-management 
tool, providing users with information regarding selected cells in the current or other workbooks. 

Click Watch Window on the Formulas tab of the Ribbon to open the Watch Window. In default, the Watch 
Window floats on the face of the worksheet, but it can be docked on any edge of the worksheet by 
dragging it to the desired location. Cells or ranges of cells can be added to the Watch Window by 
highlighting the cells of interest and clicking Add Watch as shown in Figure 1. 

 

Figure 1 - Using the Watch Window to Observe Changes to Cells 

Defined watches are saved when a workbook is saved so that they will be available the next time the 
workbook containing them is opened, even if the Watch Window has been closed prior to saving the 
workbook. 

Working with Excel’s Goal Seek Function 
Excel’s Goal Seek function is a tool that allows users to “back-in” to the value needed in a variable to 
produce a specific result. In other words, use Goal Seek when you already know what the answer is – or 
should be – and just need identify the value in a specific variable that will produce the intended result. 

In the following example, suppose Greg Adams, a budget analyst at GTM Manufacturing, has the 
responsibility of determining what level of sales revenue is needed to provide gross profit of $6 million 
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for the upcoming fiscal year. Greg knows that GTM’s gross profit percentage averages 29%, so he could 
simply divide $6 million by 29% to arrive at the necessary sales revenue of $20,689,655. Greg could also 
use Goal Seek to solve this problem. 

Using Goal Seek, Greg might construct a model similar to that shown in Figure 2. 

   

Figure 2 - Goal Seek Model 

When Greg constructs this model, he would access the Goal Seek dialog box by choosing What-If Analysis 
from the Data tab and selecting Goal Seek. Upon entering the information shown in Figure 2, Greg clicks 
OK in Goal Seek dialog box. Upon doing so, Goal Seek calculates the result and displays it as shown in 
Figure 3. 

 

Figure 3 - Completed Goal Seek Calculation 

Of course, rarely are the calculations required in preparing budgeting and forecasting models as simple as 
the one required by Greg in the previous example. Consequently, a more complex example is in order. In 
the next example, John Adams, the Chair of the School of Accountancy at State University, proposes to 
establish an endowed professorship at the school to teach Applied Technology to Accounting majors at 
the school. In considering the expected rate of return on the endowment, a professor’s initial annual 
salary, and annual cost of living and merit raises, Adams is attempting to determine the level of fundraising 
required to endow the professorship for a term of thirty years. 
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After performing due diligence, Adams makes the following initial estimates regarding variables affecting 
the endowment. 

Expected Annual Investment Earnings Rate 7.5% 
Expected Annual Cost of Living and Merit Raises 4.5% 
Expected Initial Salary $160,000 

To begin the process, Adams creates a schedule, a portion of which is shown in Figure 4. As shown there, 
if the professorship were endowed at $1 million, it would run out of money by year 8. 

  

Figure 4 - Proposed Endowment Schedule for State University 

Adams returns to the model and opens the Goal Seek dialog box. There, he uses Goal Seek to solve the 
equation by setting cell H34 (the ending balance for year 30) to 0 by changing the value in cell B4 (the 
beginning balance in the endowment) as shown in Figure 5. Once Adams establishes these parameters 
and clicks OK, Goal Seek approximates the amount required in the endowment at $3,051,7641. Note that 
the answer is approximate because, by default, Excel only runs 100 iterations in an attempt to find the 
correct answer. If Adams required a greater degree of precision, he could adjust the number of iterations 
for the workbook in Excel’s Formula Options. Additionally, rounding functions in the workbook also cause 
the calculation to be less accurate than is otherwise possible. 

 
1 Those familiar with Excel’s financial functions could also solve this problem by using Excel’s PV function. 
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Figure 5 - Establishing Goal Seek Parameters for  
Calculating Required Initial Endowment 

While some avoid using Goal Seek because it is capable of solving equations with one variable only, as 
demonstrated above, the usefulness of Goal Seek is not limited to only simple “what-if” problems. 
Nonetheless, when requiring functionality in Excel to assist in solving multivariable problems, Excel’s 
Solver function is a better tool. 

Managing Different Sets of Assumptions with Scenario Manager 
Scenario Manager is a feature in Excel that provides users with the ability to see results under different 
sets of assumptions without needing to create multiple versions of worksheets or workbooks. In Scenario 
Manager, users specify the variable(s) to be changed and what the changes are. Then, whenever results 
are to be displayed based on a particular set of assumptions, Scenario Manager automatically recalls the 
assumptions and inserts them into the spreadsheet. 

To illustrate how Scenario Manager works, consider the budget assumptions shown in Table 1 for three 
different sets of circumstances. 

 Best Case Most Likely Case Worst Case 

A/R Collection Period 34 37 43 

Days Sales In Inventory 18 24 36 

Days Purchases In A/P 27 34 45 

Gross Profit Percentage 49% 47% 43% 

Interest Rate On Line Of Credit 5% 6% 8% 

Total Sales $900,000 $800,000 $700,000 

Wages $195,000 $200,000 $225,000 
Table 1 - Scenario Manager Assumptions 

Each of the assumptions associated with each set of circumstances can be loaded and saved under 
Scenario Manager by selecting Data, What If Analysis, and Scenario Manager from the Ribbon and 
clicking the Add button. In the Add Scenario dialog box shown in Figure 6, enter a name for the scenario, 
the cells to be changed, and any desired comments. Clicking the OK button advances users to the Scenario 
Values dialog box shown in Figure 7. 
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Figure 6 – Adding Scenario Dialog Box 

In the Scenario Values dialog box, the values to be associated with each variable being changed under the 
scenario are entered. Once all values have been entered, click OK to save the data. 

  

Figure 7 - Scenario Values Dialog Box 

To see the results of a particular scenario, simply double-click the desired scenario in the Scenario Manger 
dialog box. At that point, the cell values associated with each variable identified in Scenario Manager are 
changed to reflect the values for that scenario. This effectively allows users to track multiple versions of 
the same budget. Further, Scenario Manager allows users to generate a Scenario Summary report showing 
the impact of changing the variables under each Scenario on selected “Result Cells.” Figure 8 displays an 
example of one such report. 
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Figure 8 - Scenario Summary Report 

 

Using Solver to Maximize Resources 
One of the key considerations for anyone involved in preparing revenue forecasts is to maximize profits, 
given available resources and operational and financial constraints. Constraints on profitability may take 
the form of distribution restrictions, production capacity limits, scarce inventory, or shortages of working 
capital caused by growth in accounts receivable or inventory. Whatever the nature of the constraints, it 
is the goal of every financial manager to find solutions that maximize the value of the organization. Excel's 
Solver add-in can assist in that process. 

Solver is used to find optimal solutions to linear programming models. For example, Solver can be used to 
maximize gross profits by calculating the optimal mix of products sold, to minimize interest expense by 
finding an optimal capital structure for the company, or to maximize production output by calculating the 
most efficient production runs. Solver optimizes a value in one cell of a workbook by adjusting various 
input cells, subject to user-specified constraints placed on the input cells. 

In this example, the CFO of a medical technology lab seeks to maximize the gross profit generated by a 
piece of testing equipment. The equipment can perform three different tasks, each with different billing 
rates, marginal costs, and gross profits. Further, the maximum number of units that can be sold of each 
procedure varies. Table 2 displays the relevant data. 
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 Task A Task B Task C 
Billing Rate $350 $250 $200 
Marginal Cost $175 $50 $100 
Gross Profit Per 
Unit Sold 

$175 $200 $100 

Max Number Of 
Sales Per Year 

500 minus 1/2 of the 
instances of Tasks B 
and C sold for the 
year 

500 minus 1/2 of the 
instances of Task C 
sold for the year 

500 

Table 2 - Relevant Data for a Solver Equation 

In addition to the data presented in Table 5, no more than 750 procedures in total can be sold during the 
year, and a minimum of 50 units of each procedure must be sold. Given these constraints, the CFO must 
calculate the optimal mix of sales units of each task in order to maximize overall gross profit. Using Solver, 
a solution for this complex revenue maximization model can be calculated in short order. 

First, build the basic structure of the worksheet as shown in Figure 8. The second panel in the figure 
displays the underlying formulas. 

  

Figure 9 - Constructing a Worksheet with the Appropriate Structure and Formulas 

To begin the process of finding a solution, click Solver on the Data tab to open the Solver Parameters 
dialog box as shown in Figure 10. In the Solver Parameters dialog box, specify the target cell to be 
optimized, in this case cell F7. The variable cells to be adjusted include the range of cells B6:D6. The 
relevant constraints are described in the table above. Click the Solve button, and Solver will attempt to 
find a solution based on the input cells and constraints identified. When the results are calculated, select 
Keep Solver Solution in the Solver Results dialog box and click OK. 
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Figure 10 - Specifying the Parameters for a Solver Optimization 

The solution suggested by Solver is presented in Figure 11. Maximum profits are generated when 225 
units of Task A, 475 units of Task B, and 50 units of Task C are sold. Closer inspection reveals that at least 
50 units of each task are sold, that the total number of all tasks being sold is less than or equal to 750 
units, and that the number of units of each task sold is less than or equal to the maximum number 
available. 

  

Figure 11 - Results of Solver Produced Profit Maximization 

In addition to the computational efficiency of Solver, users can benefit from its documentation features 
in the form of several reports. The Solver Answer Report is shown in Figure 12. 
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Figure12 - Answer Report Generated with a Solver Solution 

In addition to Answer reports, Solver can also generate Sensitivity Analysis and Limits reports. Further, 
you can save Solver solutions as Scenarios to be recalled later in Scenario Manager.  

Moving Averages 
This example teaches you how to calculate the moving average of a time series in Excel. A moving average 
is used to smooth out irregularities (peaks and valleys) to easily recognize trends. 
1. First, let's take a look at our time series. 
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2. On the Data tab, in the Analysis group, click Data Analysis. 

 

Note: can't find the Data Analysis button? Click here to load the Analysis ToolPak add-in. 
3. Select Moving Average and click OK. 

 

https://www.excel-easy.com/data-analysis/analysis-toolpak.html
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4. Click in the Input Range box and select the range B2:M2. 

5. Click in the Interval box and type 6. 

6. Click in the Output Range box and select cell B3. 

7. Click OK. 

 

8. Plot a graph of these values. 
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Explanation: because we set the interval to 6, the moving average is the average of the previous 5 data 
points and the current data point. As a result, peaks and valleys are smoothed out. The graph shows an 
increasing trend. Excel cannot calculate the moving average for the first 5 data points because there are 
not enough previous data points. 

9. Repeat steps 2 to 8 for interval = 2 and interval = 4. 

 

Conclusion: The larger the interval, the more the peaks and valleys are smoothed out. The smaller the 

interval, the closer the moving averages are to the actual data points. 
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